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Abstract

These Application Notes describe the procedures for configuring Session Initiation Protocol
(SIP) Trunking between the service provider Telecommunications Services of Trinidad and
Tobago and Avaya IP Office 8.1.

During the interoperability testing, Avaya IP Office was able to interoperate with the
Telecommunications Services of Trinidad and Tobago Soft switch via SIP trunking. This test
was performed to verify SIP trunk features including basic call, call forward (all calls, busy, no
answer), call transfer (blind and consult), conference, and voice mail. The calls were placed in
both directions using various endpoint types.

Telecommunications Services of Trinidad and Tobago is a member of the Avaya DevConnect
Service Provider program. Information in these Application Notes has been obtained through
DevConnect compliance testing and additional technical discussions. Testing was conducted
via the DevConnect Program at the Avaya Solution and Interoperability Test Lab.
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1. Introduction

These Application Notes describe the procedures for configuring Session Initiation Protocol
(SIP) Trunking between the service provider Telecommunications Services of Trinidad and
Tobago and an Avaya IP Office solution.

In the sample configuration, the Avaya IP Office solution consists of an Avaya IP Office 500v2
Release 8.1, Avaya Voicemail Pro, Avaya IP Office soft clients and Avaya desk phones,
including SIP, H.323, digital, and analog endpoints.

The Telecommunications Services of Trinidad and Tobago SIP Trunk Service referenced within
these Application Notes is designed for business customers in Trinidad and Tobago. Customers
using this service with the Avaya IP Office solution are able to place and receive PSTN calls via
a broadband WAN connection and the SIP protocol. This converged network solution is an
alternative to traditional PSTN trunks such as analog and/or ISDN-PRI trunks. This approach
generally results in lower cost for the enterprise. Telecommunications Services of Trinidad and
Tobago will be referred to as TSTT here after.

The Avaya IP Office system can be configured to authenticate with the SIP service provider
using either SIP Trunk Registration or Static IP Authentication. These Application Notes cover
the configuration of IP Office using Static IP Authentication with the service provider.

2. General Test Approach and Test Results

A simulated enterprise site was configured in the test lab using Avaya IP Office, connected to the
TSTT SIP Trunk Service via a SIP trunk over the public Internet. This scenario may differ from
a real customer environment, in which a dedicated private network connection could be provided
by TSTT to the actual customer site.

The configuration shown in Section 3 - Figure 1 was used to exercise the features and
functionality tests listed in Section 2.1.

DevConnect Compliance Testing is conducted jointly by Avaya and DevConnect members. The
jointly-defined test plan focuses on exercising APIs and/or standards-based interfaces pertinent
to the interoperability of the tested products and their functionalities. DevConnect Compliance
Testing is not intended to substitute full product performance or feature testing performed by
DevConnect members, nor is it to be construed as an endorsement by Avaya of the suitability or
completeness of a DevConnect member’s solution.

Testing was performed using IP Office 500v2 R8.1, but results also apply to IP Office Server
Edition R8.1. Note that IP Office Server Edition requires an Expansion IP Office 500 v2 RS8.1 to
support analog or digital endpoints and trunks.
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2.1. Interoperability Compliance Testing

To verify SIP trunking interoperability, the following features and functionality were covered
during the interoperability compliance test:

Response to SIP OPTIONS queries.

Incoming PSTN calls to various phone types. Phone types included SIP, H.323, digital
and analog telephones at the enterprise. All inbound PSTN calls were routed to the
enterprise across the SIP trunk from the service provider.

Outgoing PSTN calls from various phone types. Phone types included SIP, H.323,
digital, and analog telephones at the enterprise. All outbound PSTN calls were routed
from the enterprise across the SIP trunk to the service provider.

Inbound and outbound PSTN calls to/from soft clients.

Various call types including: long distance, international, outbound toll-free, etc.
Codec’s G.711MU and G.729A (For Codec G.729A Test Results refer to Section 2.2).
Caller ID presentation and Caller ID restriction.

DTMF transmission using RFC 2833.

Voicemail navigation for inbound and outbound calls.

User features such as hold and resume, transfer, and conference.

Off-net call forwarding and twinning.

2.2. Test Results

Interoperability testing with TSTT was completed successfully with the exception of the
observations/limitations described below:

SIP REFER - On PSTN calls to or from IP Office that are transferred back to the PSTN
on the SIP trunk, TSTT responds with a “202 Accepted” to the REFER message sent by
IP Office, but the call between the two PSTN endpoints drops and the PSTN phone
receives re-order tone. REFER needs to be disabled in IP Office for the Call Transfer to
complete successfully; otherwise the call transfer will fail. The implication is that IP
Office SIP trunk channels are not released after the call transfer is completed and two (2)
trunk channels will remain connected/busy for the duration of the call.

T.38 or G.711 Pass-Through fax calls — With IP Office Fax Transport Support set as
T.38 or T.38 Fallback on the SIP Line/VoIP, on outbound calls IPO>PSTN) TSTT
did not send a re-INVITE to switch from G.711 to T.38. TSTT’s recommendation is not
to use T.38 fax transport, only G.711 fax Pass-through. With IP Office Fax Transport
Support set as G.711 on the SIP Line/VolP, fax calls were unsuccessful, thus T.38 or
G.711 fax transports are not recommended for this solution.

Codec G.729A — TSTT supports codecs G.711MU and G.729A, but during the testing
TSTT was rejecting calls with G.729A codec offer with 488 Invalid Media Type. This
issue is under investigation by TSTT.

2.3. Support
For technical support on the TSTT SIP Trunk Service offer, visit http://tstt.co.tt/
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3. Reference Configuration

Figure 1 below illustrates the test configuration. It shows the enterprise site connected to the
TSTT SIP Trunk Service through the public IP network.

TSTT Network

Genband Platform

SIP Proxy: 192.168.139.155
DIDs: 868-111-1234

Domain: tstt.co.tt y

Internet

Enterprise
& rcrrrerc ] ISP Router P

Enterprise Firewall

WAN Public

LANZ-
|P Office 500 V2. Rel 8.1 172.16.157.180

LAM: Private

L

(i)
Avaya 96xx Avaya 11XX
IPO Softphone (SIP)
|P Office Manager IP Telephones  gip Tolephones
Valca Mall Pro (H.323) IPO Phone Manager (H.323)

Avaya 9508, 1408
Digital Telephones

Figure 1: Test Configuration

Note that for security purposes, all public IP addresses and phone numbers shown throughout
these Application Notes have been edited so that the actual IP addresses of the network elements
and public PSTN numbers are not revealed.
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The enterprise site contains the Avaya IP Office 500v2 with analog and digital extension
expansion modules, as well as a VCM64 (Voice Compression Module) for supporting VoIP
codecs. The LANI1 port of Avaya IP Office is connected to the enterprise LAN while the LAN?2
port is connected to the public IP network. Endpoints include Avaya 9600 Series IP Telephones
(with H.323 firmware), Avaya 1140E IP Telephones (with SIP firmware), Avaya 1408 and
9508D Digital Telephones, analog telephones, Officejet 4500 fax machines and PCs running
Avaya IP Office Softphone configured as SIP soft clients and Avaya Phone Manager configured
as H.323 soft clients. The site also has a Windows XP PC running Avaya IP Office Manager to
configure and administer the Avaya IP Office system, and Avaya Voicemail Pro providing voice
messaging service to the Avaya IP Office users. Mobile Twinning is configured for some of the
Avaya IP Office users so that calls to these users’ extensions will also ring and can be answered
at the configured mobile phones.

For the purposes of the compliance test, users dialed a short code of 9 + N digits to make calls
across the SIP trunk to TSTT. The short code 9 was stripped off by Avaya IP Office but the
remaining N digits were sent unaltered to the network. Since Trinidad and Tobago is a country
member of the North American Numbering Plan (NANP), the users dialed 10 digits for local
calls, including the area code, and 11 (1 + 10) digits for other calls between the NANP.

In an actual customer configuration, the enterprise site may include additional network
components between the service provider and the Avaya IP Office system, such as a session
border controller or data firewall. A complete discussion of the configuration of these devices is
beyond the scope of these Application Notes. However, it should be noted that all SIP and RTP
traffic between the service provider and the Avaya IP Office system must be allowed to pass
through these devices.
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4. Equipment and Software Validated

The following equipment and software were used for the sample configuration provided:

Equipment / Software | Release / Version

Avaya

Avaya IP Office 500v2 8.1 (69)
Avaya IP Office Digital Expansion Module 10.1 (69)
DCPx16

Avaya IP Office Manager 10.1 (69)
Avaya IP Office Voicemail Pro 8.1.9203.0
Avaya 9620 IP Telephone (H.323) Avaya one-X Deskphone Edition S3.2
Avaya 1140E IP Telephone (SIP) 04.03.12.00
Avaya Digital Telephone 1408 32
Avaya Digital Telephone 9508 0.45
Avaya IP Office Softphone (SIP) 3.2.3.48.67009
Telecommunications Services of Trinidad and Tobago SIP Trunk Service
Genband Softswitch | CVM 13

5. Configure IP Office

This section describes the Avaya IP Office configuration necessary to support connectivity to the
TSTT SIP Trunk Service. Avaya IP Office is configured through the Avaya IP Office Manager
PC application. From the PC running the Avaya IP Office Manager application, select Start -
Programs - IP Office & Manager to launch the application. Navigate to File = Open
Configuration (not shown), select the proper Avaya IP Office system from the pop-up window,
and log in with the appropriate credentials. A management window will appear similar to the one
shown in the next section.

The appearance of the IP Office Manager can be customized using the View menu. In the
screens presented in this section, the View menu was configured to show the Navigation pane on
the left side, the Group pane in the center and the Details pane on the right side. These panes will
be referenced throughout the Avaya IP Office configuration.

Standard feature configurations that are not directly related to the interfacing with the service
provider (such as LAN interface to the enterprise site, Twinning and IP Office Softphone
support) are assumed to be already in place, and they are not part of these Application Notes.
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5.1. Licensing

The configuration and features described in these Application Notes require the IP Office system
to be licensed appropriately. If a desired feature is not enabled or there is insufficient capacity,
contact an authorized Avaya sales representative.

To verify that there is a SIP Trunk Channels License with sufficient capacity; click License in
the Navigation pane and SIP Trunk Channels in the Group pane. Confirm that there is a valid
license with sufficient “Instances” (trunk channels) in the Details pane. Note that the actual
License Key in the screen below was hidden for security purposes.

IP Offices License

R BOOTR (9)
1% Operator (3}
(=% O0EOO706530F
w39 System (1)
I Line (3)
2w Control Unik (4)
Ay Extension (35)
g User (33)
9 Huntsroup (1)
BX Short Code (62)
@ Service (0)
AL RAS (1)

@ WanPort {0}

. Direckory (0)

g".1\ Time Profile {0}
& Firewal Profile (1)
BB IF Route (4)

@ Account Code {0)
W License (74)

@& Tunnel (0)

ﬁ‘i User Rights {3)
ARS (1)

g'x E911 Syskem (1)

@ Incoming Call Route (2)

# RAS Location Requesk (0)

License Type
%= Essential to Branch Edition Migration
e Inkegrated Messaging
% IP Endpaink to Enterprise Branch Liser Mig
%= IP Office Dealer Support - Professional Ed
%2 IP Office Dealer Support - Standard Editio
% IP Office Distribukor Suppart - Professions
% IP Office Distribukor Suppart - Standard E
%= IPSO0 Universal PRI (Additional channels)
8= IPS00 Upgrade Skandard to Professional
R IPSO0 Yaice Metworking Channels

%= IPSO0 Yaice Metwarking Channels

S IPSec Tunneling

Bea Microsoft CRM Integration (users)

R Mobile Warker

S Maility Features

R Office Worker

R one-¥ Portal For IP Office

% Phone Manager Pro

%= Phone Manager Pro (per seat)

%2 Phone Manager Pro IP Audio Enabled (use
R Power User

% Preferred Edition (Voicemail Pro)

S Preferred Edition Additional Yoicemail Fort
%z Preferredddvanced ta Branch Edition Mic
% Proactive Reporting

R RAS LRQ Support (Rapid Response)

%= Receptionist

S Report Yiewer

8 SIP Trunk Channels

8= Small Office Edition WM (channels)

R Small Office Edition WiFi

%= Small Site Software Upgrade 255

8= Software Upgrade 255

< >

”~

Licenses

License key
License Type
License Status
Instances

Expiry Date

[3002GE

SIP Trunk Channels
Yalid

255

MNever

E SIP Trunk Channels
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5.2. LAN2 Settings

As shown in the following screen, the Name field can be used for a descriptive name of the
system. In the sample configuration, the MAC address 00E00706530F was used as the system
name, and the WAN port was used to connect the Avaya IP Office to the public network. The
LAN?2 settings correspond to the WAN port on the Avaya IP Office. To access the LAN2
settings, first navigate to System (1) = 00E00706530F in the Navigation and Group panes and
then navigate to the LAN2 - LAN Settings tab in the Details pane. Set the IP Address field to
the IP address assigned to the Avaya IP Office WAN port. Set the IP Mask field to the mask
used on the public network. All other parameters should be set according to customer
requirements.

! IP Offices System ﬁ 00EQD7T06630F (i [ %] «]<]

R BOOTR (%) Mame

i Operator (3} 7 O0EON7OES30F

2 ODEDI7O6S30F LAN Settings |valP | Wetwork Topalagy
29 System (1)
A7 Line (3)
<= Control Unit (4) 1P Mask =
A Extension (35)
4 User(33) Primary Trans. IP Address ] ] ] 0
% HuntGroup (1) ]
9% Short Code (62) Firewall Profile <Mone= v
B servic2 (0) RIP Mods More v
Al RAS (1)
) Incoming Call Route (2) [] Enable MAT
B wanPort (0)
s Directory (0)
£ Time: Prafile (0) DHCF Mode

g IF::V;:LPE:;IIE ) O server O Client ) Dislin () Disabled

g Account Code (0)

W License (74)

& Tunrel (0)

§4 user Rights (8)

‘g ARS (1)

4 RAS Location Reguest {0)
fi= E911 System (1)

System | LAM1 | LAMNZ |DNS || voicemall | Telephony | Directory Services | System Events | SMTP | SMDR. | Twinning | ¥CM | CCR | Codecs

IP Address 172 16 157 190

Humber OF DHCP [P Addresses |1 >

[ ot [ conel |[ rel

On the VolIP tab in the Details pane, check the SIP Trunks Enable box to enable the
configuration of SIP trunks. The RTP Port Number Range can be customized to a specific
range of receive ports for RTP media. Based on this setting, Avaya IP Office would request RTP
media be sent to ports in the configured range for calls using LAN2.

Avaya IP Office can also be configured to mark the Differentiated Services Code Point (DSCP)
in the IP header with specific values to support Quality of Services policies for both signaling
and media. The DSCP field is the value used for media and the SIG DSCP is the value used for
signaling. The specific values used for the compliance test are shown in the example below.
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In the RTP Keepalives section at the bottom of the page, set the Scope field to RTP, and Initial
keepalives to Enabled. This will cause the Avaya IP Office to send RTP keepalive packets at
the beginning of the calls. To avoid problems of media deadlock that can occur with certain
types of forwarded calls that are routed from the Avaya IP Office back to the network, over the
same SIP trunk.

All other parameters should be set according to customer requirements.

IP Offices System E 00E0D0706530F [ [ %X «]<]|

R BooTR (9 St System | LaM1 | L&NZ |DMS | Woicemail | Telephony | Directory Services | System Events | SMTP | SMOR | Twinning | weM | CoR | Codecs
7 Operator (3) = OIEDO70E530F
= ODEDO7O6530F LA Settings | YoIP | Metwork Topology
=29 System (1)
7, Line (3)

H.323 Gatekeeper Enable
<= Control Unit (4) o -

A Extension (35) SIP Trunks Enable
4 user(3z)

4§ HuntGroup (1)
9 Short Code (62)

[ SIF Registrar Enable

B service (D) o RTP Port Nurber Range
H.323 Auto-create Extn
ok RAS (?) Port Range (Minimum) 49152 £
R Tncoming Call Route (2)
@ WanPort {0} H.323 Auto-create User Port Range (Maximum) 53248 &
a4 Directary (0)
117 Time Profile (0} [] H.323 Remate Extn Enable
@ Firewall Profile (1)
Enable RTCP Monitoring
KA P Route (4) On Port 5005
m Account Code (D) )
o License (74) DiffSery Settings
W Tunnel (0 B& | DscPiHex) FC 3| DSCPMask(Hex) (88 3| SIGDSCP {Hex)
£ user Rights (8)
¢ ARS (1) 46 % pace 63§ | DSCP Mask #* | sIGDscP
4 RAS Location Request {(0)
E"‘ 911 System (1) DHCP Settings
Primary Site Specific Option Number (350N} 176 &
Secondary Site Specific Option Number (SSON) 24z &
WLAN Mot Present v
1100 ¥oice YLAN Site Spedfic Option Mumber (SSOM) (232
1100 Yaice YLAN IDs
RTP Kespalives
Scope RTP ~ | Perindic timeout o
Initial keepalives Enabled v
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On the Network Topology tab in the Details pane, configure the following parameters:

e Select the Firewall/NAT Type from the pull-down menu to the option that matches the
network configuration. Since no network address translation (NAT) was used in the
compliance test, the parameter was set to Open Internet. With this configuration, the
STUN Server IP Address and STUN Port are not used.

¢ Set Binding Refresh Time (seconds) to 300 (or every 5 minutes).This value is used to
determine the frequency at which Avaya IP Office will send SIP OPTION messages to
the service provider.

e Set Public IP Address to the IP address that was set for LAN2.

¢ Set Public Port to 5060.

¢ All other parameters should be set according to customer requirements.

IP Offices System E

K BOOTP (9)
{7 Operator (3)

(=59 DDEDO706530F
sy System (1)
9 Line (3)

= Contral Unit {=)

Ay Extension (35)
£ User(33)
2§ HuntGroup (1)
B3¢ shart Code (62)
B Service (D)
o RAS (1)
@ Incoming Call Route (2)
2 warPart (0)
i Directory {0)
£ Time Profile (0)
@ Firewall Profile (1)
BB 1P Route (4)
m Account Code {0
e License (74)
@& Tunnel (0}
§y User rights (8)
¥ ARS (1)
# RAS Location Request (0}
f E9L1 System (1)

Mame
S=J00EODFOES30F

00ED0706530F ) | [ o] < |

System | LAND | LAMZ | DNS | Voicemal | Telephony | Directory Services | System Events | SMTP | SMDR | Twinning | ¥CM | CCR | Codecs

LAN Settings | wolP | Metwark Topalogy

Network Topology Discovery

STUN Server IP Address | 69 a0 168 13 STUN Port #m 3

FirewallfNAT Type Open Internet -

Binding Refresh Time 300 -

{seconds)

Public IP Address 172 . 16 157 . 190

Public Port 50603 Run STUK Cancel

[] run STUN on startup

In the compliance test, the LAN1 interface was used to connect the Avaya IP Office to the
enterprise site IP network. The LAN1 interface configuration is not directly relevant to the
interface with the TSTT SIP Trunk Service, and therefore is not described in these Application

Notes.
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5.3. System Telephony Settings

Navigate to the Telephony - Telephony Tab in the Details Pane. Choose the Companding
Law typical for the enterprise location, U-Law was used. Uncheck the Inhibit Off-Switch
Forward/Transfer box to allow call forwarding and call transfers to the PSTN via the SIP trunk
to the service provider.

IP Offices System E 00E00706530F (=) [ ¥ | o<

i
R B00TP (3) o System | LamM1 | LaNz | DMS | voicemall | Telephony | Divectory Services | System Events | SMTP | SMDR | Twinming | vem | ccr | codecs
¢« Operator (3) I O0ECOFOES30F : e
). ODEOD7OB530F Telephony | Tanes & Music | Call Log
= Sysh i
T“. Li:vi ?:T)( ) Analogue Extensions Campanding Law
Switch Line:
= Contro! Unit {4) Default Outside Call Sequence Marmal ~
& Extension (35)
§ user(z3) Default Inside Call Sequence Ring Type 1 v © Uan © UtanLine
% HuntGroup (1)
Default Ring Back Sequence Ring Type 2 v
o :hmt CD;E &2 O aLaw O A-Law Line
@ ervice (0) Restrict Analogue Extension Ringsr Yoltage D
o RAS (1)
D 1ncoming Call Routs (2) Dial Delay Time (secs) 3 £ [ Dss Status
&) wanrart (0
o Directory () Dial Dielay Courit o £ Auta Hold
17 Time Profile (0 =
@ Firewall Profile (1) Default No Answer Time (secs) 15 % Dial By Mame
Kl 1P Route (4) Hold Timeout (secs) [toon = Show Account Code
m Account Code (0)
. License (74) Park Timeout (secs) B0 4 [ Inhibit OFf-Switch Forward] Transfer
% Tunnel {0} e
§3 User Rights () Ring Delay (secs) 5 E [[] Restrict Metwork Intercannect
€ ARS (1) Call Priarity Promation Time tsscs) |Disabled = [ Brop External Only Impramptu Conference
« RAS Location Request (0)
f* E911L System (1) Default Currency usD 3 [ visually Differentiake External Cal
Default Name Priority TR 2 [ Unsupervised Analog Trunk Disconnect Handling

High Quality Conferencing

5.4. Twinning Calling Party Settings

Navigate to the Twinning tab on the Details Pane. Uncheck the Send original calling party
information for Mobile Twinning box. This will allow the Caller ID for Twinning to be
controlled by the setting on the SIP Line (Section 5.6). This setting also impacts the Caller ID
for call forwarding.

IP Offices System 00E00706530F
M .
{‘ BOOTP (3} = System | LAN1 | LaM2 | DNS | voicemail | Telephony | Directory Services | System Events | SMTP | SMDR | Twinming wcM | ccr | Codecs
¢ Operator (3) % 00ED0706530F
). %2y DOEDO7OESI0F [[1 send original calling party information For Mabile Twinning
59 Syskem (1) Calling party information Far
4 Line (3) Mobile Twinning

< Control Unit {4)

HG; Reviewed: Solution & Interoperability Test Lab Application Notes 11 of 40
SPOC 11/5/2013 ©2013 Avaya Inc. All Rights Reserved. TSTT_IPOS1



5.5. IP Route

Create an IP route to specify the IP address of the gateway or router where the IP Office needs to
send the packets, in order to reach the subnet where the SIP proxy is located on the TSTT
network. On the left navigation pane, right-click on IP Route and select New.
e Set the IP Address and IP Mask of the remote TSTT SIP Proxy subnet.
e Set Gateway IP Address to the IP Address of the router used to reach the external
network. For the test configuration, this was the IP address of the local ISP router.
e Set Destination to LAN2 from the pull-down menu.

IP Offices IP Route 7 W 139.0* et -8 X v ]<]>
R BooTR (9 IP Address IP Mask 1P Route
i Operator (3) Ho.ooo 255,255, 255.25
“ DOEDO706530F [1] 1390 255,255,255,0 ||| 17 Address 192 168 133 0O
- System (1) Elisz.166.10.0 255.255.255.0 ||| 1P Mask 555 . 255 . 255 0
4 Line (3) Bl 192.168.99.0 255.255.255.0
<2 Control Urit {4) Gateway IP Address 172 . 16 . 157 . 254
A Extension (35)
§ usera) Destination LANZ v
4§ HuntGroup (1) Metric 0 e
B Short Code (62)
B service (0) [ Proxy aRP
AL RAS (1)
P 1ncoming Call Route (2)
9 warPort (0
m Directary (0)

£ Tirme Profile (0}
@ Firewall Profile (1)
A 1P Route (4)
g Account Code (0)
W License (74)
% Tunnel (0}
§ User Rights (8)
£ ARS (1)
" RAS Location Request (0)
Ex E911 System (1)

5.6. Administer SIP Line

A SIP line is needed to establish the SIP connection between Avaya IP Office and the TSTT SIP
Trunk Service. To create a SIP line, begin by navigating to Line in the Navigation Pane. Right-
click and select New— SIP Line.
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5.6.1. SIP Line Tab
On the SIP Line tab in the Details Pane, configure the parameters as shown below:
¢ Set ITSP Domain Name to the domain of the Service Provider, Avaya IP Office uses
this domain on the host portion of SIP URI in SIP headers such as the From header.
¢ Check the In Service box.
Check the Check OOS box. With this option selected, IP Office will use the SIP
OPTIONS method to periodically check the SIP Line.
Set Call Routing Method to Request URI.
Check the Caller ID from From header box.
Set Send Caller ID to Diversion Header.
Uncheck the REFER support box. IP Office will not send REFER headers for calls that
are transferred back to the PSTN. See Section 2.2 for more information.
Set UPDATE Supported to Allow.
e Default values may be used for all other parameters.

IP Offices Line B SIP Line - Line 17 g -E X v <
R BooTe (9 Line Humber | Line Type Line 5| S1P Line: (rransport||sie URT |votp | 738 Fax |5TP Credentials
{# Operator (3) 1 PRI 24 (Universal) PRI
(=% ODEODFOES30F 2 PRI 24 (Universal] PRI Line Mumber 17 &
“=p System (1) 17 SIP Line
47 Line (3 ITSP Domain Mame | Estt.coutt In Service
2o Control Unit (4)
Use Tel URT
A& Extension (35) =e e o
i useram S Check 005
4 HurtGroup (1)
8% sShort Code (62) National Prefiz i} Call Routing Method Request LRI v
B Service () ot leod Originator number For
ol RAS (1) CLELTY 000 forwarded and twinning calls

@ Incoming Call Route (2) International Prefix Mamme Priority System Default w

¥ wanPort (0)
@ Directory (0) Caller 1D fram From header

£47) Tirne Profile (0} Send From In Clear (|
@ Fireweall Profile (1) User-Agent and Server
@l 1F Route (4) Headers
& Account Code () Send Caller ID Diversion Header -
W License (74)
% Tunnel (0) Association Method | By Source IP address b
5 user rights (8) F]
' REFER Support

¢ ARS (1)

' RAS Location Request (0)
Ex E911 System (1)

UPDATE Supported | Allow v
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5.6.2. Transport Tab

Select the Transport tab and set the following:

Set the ITSP Proxy Address to the IP address of the TSTT proxy server.

Set Use Network Topology Info to LAN2 as configured in Section 5.2.

[

e Set the Layer 4 Protocol to UDP.
[ ]

¢ Set the Send Port to 5060.

[ )

IP Offices Line

& BOOTP (9} Line Mumber | Line Type Line 3|

% Operator (3) 1 PRI 74 (Liniversal) PRI
)=y DOEOO7DRS30F -2 PRI 24 (Universal) PRI
=y System (1) 17 SIP Line:

7 Line (3)

= Control Unilk (4)
4y Extension (35)
§ User(3am
2§ HuritGroup (1)
B Short Code (62)
B Service (0)
AL RAS (1)
@ Incoming Call Raute (2)
2 wanPart (0}
o Directory (0)
£ Time Profile (0)

Default values may be used for all other parameters.

SIP Line - Line 17*

SIP Line Transport |SIP URI |wolP | T38 Fax | SIF Credentials

ef -8 X<

ITSP Proxy Address | 192.168.139.155

NMetwork Canfiguratian

Layer 4 Protocol LDP v Send Port  [SO60 E
Use Metwork Topology Info  [LAM 2 v

Explicit DNS Server(s) o a i} 0 a i] 1} 1}

Calls Raute via Registrar

Separate Registrar
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5.6.3. SIP URI Tab

A SIP URI entry needs to be created to match each incoming number that Avaya IP Office will
accept on this line. Select the SIP URI tab, and then click the Add button and the New Channel
area will appear at the bottom of the pane. To edit an existing entry, click an entry in the list at
the top, and click the Edit... button. In the example screen below, a previously configured entry
was edited. For the compliance test, a single SIP URI entry was created that matched any DID
number assigned to an Avaya IP Office user. The entry was created with the parameters shown

below:

e Set Local URI, Contact and Display Name to Use Internal Data. This setting allows
calls on this line whose SIP URI match the number set in the SIP tab of any User as
shown in Section 5.8.

® Associate this line with an incoming line group by entering a line group number in the
Incoming Group field. This line group number will be used in defining incoming call
routes for this line. Similarly, associate the line to an outgoing line group using the
Outgoing Group field. The outgoing line group number is used in defining short codes
for routing outbound traffic to this line. For the compliance test, a new incoming and
outgoing group 17 was defined that only contains this line (line 17).

e Set Max Calls per Channel to the number of simultaneous SIP calls that are allowed
using this SIP URI pattern.

IP Offices Line

Line Mumber | Ling Type Ling 5|

R BOOTP(3)

4 Operator (3)

% ODEOD706530F
5y System (1)
% Line (33
<2 Control Uit [4)
A Extension (35)
4 user(az)
4§ HuntGroup (1)
9 Short Code (62)
B service (0)
o RAS (1)

8 WanPort (0)

o Directory (0)

£ Time Profile (o)

@ Firswall Profile (1)

E@l 1P Route (4)

@ Account Code (0)
% License (74)

& Tunnel (0)

£ user rights (8)
¥ ARS (1)

Ex E911 System (1)

@ Incoming Call Route (2)

" RAS Lacation Request (0)

PRI 24 (Lniversal] PRI
PRI 24 (Universal) PRI
SIP Line

SIP Line - Line 17

SIP Line| Transport| SIP URT olp | 735 Fax |SIP Credentials

Channel  Groups
i 17 17

Edit Channel
Via

Local URT
Cantact

Display Mame
AL
Reqgistration
ITncoming Graup
Qutgoing Group

Max Calls per Channel

Yia LocalURI  Contact  Display Mame PAI  Credential  Max Calls

i 0: <Mon... 10

172.16.157.190

Use Internal Data

£ 12 %] [2

el -E X v <]

Add...
Remove

Edit...

Cancel
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5.6.4. VoIP Tab
Select the VoIP tab to set the Voice over Internet Protocol parameters of the SIP line. Set the

parameters as shown below:
¢ In the sample configuration, the Codec Selection was configured using the Custom
option, allowing an explicit ordered list of codecs to be specified. The buttons allow
setting the specific order of preference for the codecs to be used on the line, as shown.
TSTT supports codec’s G.711MU and G.729A, during the testing TSTT was rejecting
calls with G.729A codec offers with 488 Invalid Media Type, as described in Section

2.2

¢ Set Fax Transport Support to None. T.38 or G.711 fax transports are not
recommended for this solution, as described in Section 2.2.

¢ Set the DTMF Support field to RFC2833. This directs Avaya IP Office to send DTMF
tones using RTP events messages as defined in RFC2833.

¢ (Check the Re-invite Supported box to allow for codec re-negotiation in cases where the
target of an incoming call or transfer does not support the codec originally negotiated on

the trunk.

¢ Check the PRACK/100rel Supported box, to advertise the support for provisional
responses and Early Media to TSTT.

e Default values may be used for all other parameters.

IP Offices Line iz P =Rac Ik AR

R E0OTP (3 Gdehdi e Line 5| |1 Line [ Transport | SIP URL ¥oIP 738 Fax| SIP Credertials
¢« Operator {3) ] PRI 24 (Universal) PRI
%= DOEDO706530F o2 PRI 24 (Universal) PRI Codec Selection Custom
’I‘h‘. fi:‘j?g(l) ot SABLie, Unused Selected Re-invite Supparted
i G711 ALAW B4K d @711 ULAW 64K .
® E;F::,Z:;nég) S .720(0) 8 Co-ACELP [ Use Offeret's Preferred Codec
723 16KI FRHLG [ codec Lockdown
& User(33)
# HuntGroup (1)
R ot o 165 =T PRACK]100rel Supported
B Service (0)
L RAS (1)
P Incoming Call Route (2)
3 wanPort (0) =5
a4 Directory (0)
7 Time Profile (0}
@ Firewall Profile (1)

3 [] walP Silence Suppression

Fax Transport Support Mone ¥

Kl 1P Route 14) Cal Initiation Timeout (s) |4 v
am Account Code (D)
e License (74) DTMF Support RFCZ833 v

% Tunnel (0}
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5.7. Extension

In this section, an example of an Avaya IP Office Extension will be illustrated. In the interests of
brevity, not all users and extensions shown in Figure 1 will be presented, since the configuration
can be easily extrapolated to other users and extensions. To add an Extension, right click on
Extension then select New > Select H323 or SIP.

Select the Extn tab. Following is an example of extension 3042; this extension corresponds to a
H.323 extension.

R B00TR (3) 1d Extension | Module | Port Extn | vorp
¢ Operator (3) &5 38 BFZ 1
=)y O0EOO70RS30F 26 4002 EP2 2 Extension Id 5009
= System (1) &z7 4003 BPZ 3
1 Line (3) % v o 5 Base Extension |an4z
= Control Unit (4) I I EP2 5 Caller Display Type
A Extension (35) &30 4006 BP2 o
% :;g,téga) " &30 4007 B2 ; Reset Walume after Calls O
E untGroup
ealh | T e P
B Service (0)
% Ras (D) 10z 3044 1 z - 5
 Incoming Call Route (2) &0z a01L 1 3 fesue L
&9 wanpart (o) 104 4012 1 4 - i
a4 Directory (0) ‘ﬁms 4 ! 5 i
7 Time Profile (0 &106 4014 1 &
@ Firewall megle)(l) &107 4015 1 7 Disable Speakerphone O
Ell 7 Route (4) 105 4016 1 8
& Account Code (0) 109 4017 1 ]
e, License (74) & 1l0 4018 1 10
¥ Tunnel (0 111 4019 1 11
f User Rights (8 &1z 4020 1 12
¢ ARS(1) 113 4021 1 13
@ RéS Location Request (0) | gsqy4  gpoz 1 14
i E9LL System (1) &5 a0z 1 15
A 11e 4024 1 18
“eE000 3047 0 ]
w8001 3050 0 o
G002 3041 i i}
“eE003 3040 ] ]
“e.5004  SO0L [ o
. E005 4028 i i}
e E006 4027 1] 1]
5007 4029 0 o
5005 3048 i i}
w8009 3042 0 o
" E010 3055 1] ]
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Select the VOIP tab. Use default values on VoIP tab. Following is an example for Extension
3042; this extension corresponds to a H.323 extension.

IP Offices Extension

R BOOTP (%)
4% Operator (3)
NEQNTOGS30F
2y System (1)
A7 Line (3)

< Control Linit (4}
A Extension (35)
§ User(33)
3§ HuntGroup (1)
8¢ shart Code (62)
B service (0)
i RAS (1)
@ Incoming Call Route (2)
) wanPort (0)
s Directory (0}
£7 Time Profile (0)
@ Firewall Prafile (1)
BB IF Route (4)
m Account Cods (D)
., License (74)
W& Tunnel {0}
3 user Rights ()
¥ ARS (1)
" RAS Location Request (0)
fx E311 System (1)

d
25

E ki
&7

E ]
e

E kil
31
iz
11
102
103
104
105
106
& 107
& 108
& 109
110
111
&1z
113
o114
115
116
5000
5001
w0002
5003
6004
5005
5006
6007
e, 5005
5009
%5010

Extension
3049
4002
4003
4004
4005
4006
4007
4008
3043
3044
4011
4012
4013
4014
4015
4016
4017
4018
4019
4020
4021
402z
4023
4024
3047
3050
3041
3040
S001
4028
4027
4023
3045
a4z
3055

Module
BPZ
BPz
BPZ
BPZ
BPZ
BPZ
BPZ
BPZ

R T R I - I - B e U RN

Port

Extn | VoIP
1P Address

MAC Address

Codec Selection

TOM->IP Gain
IP->TOM Gain

Supplementaty Services

H323 Extension: 8009 3042

Syskem Default

| @711 ALaw 64
G.722 84K
G.723.1 8K3 MP-MLQ

[Defaut
Default

None

R

<

==

|&. 711 LLaw 64K

G.729(a) Bk CS-ACELP

g - X v <]

|:| WolIP Silence Suppression

] Enable Faststart for
non-Avaya IP phones

out Of Band DTMF
[ Local Tones

#llows Direct Media Path

[ Reserve Avaya IP endpoint license

[ reserve 3rd party IP endpaint license:
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5.8. Users

Configure the SIP parameters for each user that will be placing and receiving calls via the SIP
line defined in Section 5.6. To configure these settings, first navigate to User in the left

Navigation Pane, and then select the name of the user to be modified in the center Group Pane.
In the example below, the name of the user is Ext3042 H323.

R BoOTR(m)
¢« Operator {3)

=) -%%¢ DOEOO706530F
=y System (1)
4 Line (33

= Control Unit (4)

A Extension (35)
& User(33)
% HuntGroup (1)
8% Short Cade (62)
B Service (0)
ol RAS (1)
P Incoming Call Route (2)
3 wanPort (0)
4z Directary (0}
7 Time Profile (0}
@ Firewall Profile (1)
[l 7 Route (4)
am Account Code (D)
S License (74)
i Tunnel (0}
£ User Rights (8)
¢ BRS(1)
# RAS Location Request (1)
f= E9LL System (1)

Mame
Ext3040 H323
Ext3ndl H3Z3
Ext3042 H3Z3
Ext3043 Digital
Ext3044 Digital
Ext3047 SIP
rExt3043 H323
Ext3049 Fax
Ext3055 H323
Extn4002
Extn4003
Extn4004
Extn4005
Extn4006
Extn4007
Extn4008
Extn4011
Extn4012
Extn4013
Extn4014
Extn4015
Extn4016
Extn4017
Extn4015
Extn4019
Extn40z0
Extn4021
Extn40zz
Extn4023
Extn4024
rghiolser
fmRemateManager
§rsip3050

IP Offices User B Ext3042 H323: 3042
Extension
3040 _
3041 Marme Ext3042 H3Z3
304z
o
043 Password |
3044 Confirm Password rokik
047 B =
3048 Full Mame: Ext3042 H323
e Exkension | 3042
3055
4002 Email Address
4003 te]
004 o8
4005 Priarity s
4006
4007 System Phone Rights Nane
008 Profile Basic Liser
4011 5
[ receptionist
401z
4013 Enable Softphone
ALY [[] Enable one-% Portal Services
4015
4016 Enable one-+ TeleCommuter
4017 [[] Enable Remate Warker
4018
anta Enable Flare Flare Mode
4020 5
Ex Directar
4021 | Y
- Dewice Type Avaya 9620
023 ta Y
4024
User Rights
User Rights wiew User data
3050
wharking hours time profile
‘working hours User Rights
Out of hours User Rights

=Rac Ik AR

User | voicemail | DND ShortCodes | Source Numbers | Telephony | Forwarding | Dial In | Voice Recording | Button Programming | Menu Programmi € »
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Select the SIP tab. The values entered for the SIP Name and Contact fields are used as the user
part of the SIP URI in the From and Contact headers for outgoing SIP trunk calls. In addition,
these settings are used to match against the SIP URI of incoming calls without having to enter
this number as an explicit SIP URI for the SIP line (Section 5.6). The example below shows the
settings for user “Ext3042 H323”. The SIP Name and Contact are set to one of the DID
numbers assigned to the enterprise by TSTT. In the example, DID number 1111234 was used.
Only the last seven digits of the DID were assigned since TSTT only sends seven digits without
the area code (868). The SIP Display Name (Alias) parameter can optionally be configured with
a descriptive name.

If all calls involving this user and a SIP Line should be considered private, then the Anonymous
box may be checked to withhold the user’s information from the network.

IP Offices 7 Ext3042 H323: 3042*
R Boote (9) it (B Buttan Programming | Menu Programming | Mabily | Phone Manager Options || Hunt Group Membership || Announcements | SIP | Personal Direckory | | € #
44 Operator (3) Ext3040H323 3040
= % QUEDOPOESI0F A0 HAZE 3041 SIP Mame: 1111234
7 System (1) Ext3042H323 3042
7 Line (3) Exta043Digtal 3043 SIP Display Mame (Alias) |Ext3042 H323
= Contral Unik {4) Ext3044 Digital 3044 Contact 1111234
£ Extension (35) EXI047SIP 3047
B User (s EXtI4E HAZE 3043
8§ Hurkroun (1) B3040 Fax 3049 [ Anonymaus
J shert Codeloz) [EXtA0S5 HaRa 3055
@ service () Extreb10z 4002
ol RAS (1)
€ Incoming Call Raute (2) E’t”:sgj :Egj
WanPart (0 it
fﬂ Directory (1) Extreb10s 4005
£ Time Profile (0) Extn4006 4006
@ Firewall Profile (1) Extn4007 4007
A P Route (4) Extrebnns 4008
@ Account Code (0) Extn4011 4011
& Licerise (74) Extre12 4012
@& Turnel (0) Extnd013 4013
T3 User Rights (5) Extn4014 4014
AR (1) Ext4015 4015
# RS Lacation Request (1) ey B
Fx Ea1t system (1) Extr017 4017
Extrebls 4018
Extreb19 4ma
Extre20 4020
Extrebz1 4021
Extrebnz2 anzz
Extrz3 4023
Extreb1zd 4024
pgHoLiser
WrgRemoteManager
Emsipansn 3050
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Select the Voice Mail tab. The following screen shows the Voicemail tab for the user with
extension 3042. The Voicemail On box is checked. Voicemail password can be configured using
the Voicemail Code and Confirm Voicemail Code parameters. In the verification of these
Application Notes, incoming calls from TSTT SIP Trunk to this user were redirected to
Voicemail Pro after no answer. Voicemail messages were recorded and retrieved successfully.
Voice mail navigation and retrieval was performed locally and from PSTN telephones to test

DTMF using RFC 2833.

IP Offices User :

R BoOTR (3 Name Extension
% Operatar (3) Ext3040 H323 3040
=% ODEDO706530F | Ext3041 H323 3041
= System (1) Exta042 H3za 3042
T4 Line (3} Ext3043 Digtal 3043
< Control Unit {4) Ext3044 Digal 3044
& Extension (35) ImExtaoa7 SIP 3047
ﬁﬂ asg’téﬂ) o mEXCA4E HAZE 3046
Lnearogp Ext3049 Fax 3040
:chart Code (62) ImExt30S5 H3Z3 3055
@ servce () Extnd002 4002
ok RAS (1)
@ Incoming Cal Route (2) X o
&) wanort (0) Extn4004 4004
s Directory (0) Extn4005 4005
£7) Time Profie (0) Extna006 4006
@ Firowal Profile (1) Extn4007 4007
Bl 17 Route (4 Extnd008 4008
m Account Code (D) Extn4011 4011
S License (74) Extnd012 a1z
0 Tunnel (0 Extn4013 4013
fl User Rights (3) Extri40l+ 4014
EARS (1) Extnd015 4015
# RAS Location Request (0) ey e
fx E911 system (1) Extrd0L7 4017
Extnd018 4018
Extn4019 4019
Extn4020 4020
Extnd021 4021
Extni022 4022
Extnd023 4023
Extnd0z4 4nz4
iNoUsar
;RemoteManager
§rsip30s0 3050

Woicemnail Code i

Confirm Yoicemall Code |+

Woicermnail Email

OFf Copy Forward
DTMF Breakout

Reception [ Breakout {DTMF *0/0)
Breakout (DTMF 2

Breakout (DTMF 3)

Alert

Ext3042 H323: 3042*

System Defaulk ()
Syskern Default ()

System Default ()

Voicemail On

voicemail Help

[ woicemail Ringback
Voicemail Email Reading

[ ums web Services

x-S X v <>

User | Woicemail | DMD | ShortCodes | Source Mumbers | Telephory | Forwarding | Dial In | Yoice Recording | Eutton Programming | Menu Programmi 4 *

HG; Reviewed:
SPOC 11/5/2013

Solution & Interoperability Test Lab Application Notes
©2013 Avaya Inc. All Rights Reserved.

21 of 40
TSTT_IPOS81



Select the Telephony tab, then Call Settings tab as shown below. Check the Call Waiting On
box to allow an Avaya IP Office phone logged in as this extension to have multiple call

appearances. Note: Call Waiting On is necessary for call transfer.

IP Offices SEL

R BoOTP (3

Operator (3]

% O0OEDO70E530F
=27 System (1)
7% Line (3)

= Control Urit [4)

A& Extension (35)
4 user(az)
4§ HuntGroup (1)
9 Short Code (62)
B service (0)
s RAS (1)
R Tncoming Call Route (2)
&) wanpart (0)
o#m Directary (0)
17 Time Profile (0)
@ Firewall Profile (1)
BB P Route (4)
@m Account Code (0}
% License (74)
& Tunnel (0)
£ user Rights (8)
‘g ARS(1)
4 RAS Location Request {(0)
fi= E911 System (1)

INarne
Ext3040 H323
Ext3041 H3Z3
Ext304z H3z3
Ext3043 Digital
Ext3044 Digital
T Ext3047 SIP
jExt3043 H3Z3
Ext3049 Fax
rExE3055 H323
Extn4002
Extn4003
Extn4004
Extn4005
Extn400&
Extn4007
Extn4008
Extn4011
Extn4012
Extn4013
Extn4014
Extn4015
Extn4016
Extn4017
Extn4018
Extn4019
Extn40z0
Extn4021
Extn4022
Extn40z3
Extn40z4

Wpghiolser
;RemoteManager

§rsip3os0

Extension
3040
3041
304z
3043

3050

oicemail | DHD

Call settings | Supervisor Settings | MultiFine Options | Call Log

<

Transfer Return Time (secs) |Off

Call Cost Mark-Up 100

Ext3042 H323: 3042*

shortCodes | Source Mumbers | Telephony | Forwarding | Dial In | Yoice Recording || Button Programming | Menu Programmi 4 ¥

Cutside Call Sequence Default Ring v
Inside Call Sequence Default Ring v
Ringback Sequence Default Ring |
Mo answer Time (secs) System Default (15) i

Wrap-up Time (secs) 2

- X v <>

Call Waiting On
Answer Cal Walting On Hald
[ Busy On Held

[ offhook Skation

Select the Mobility tab. In the sample configuration user 3042 was one of the users configured to
test the Mobile Twinning feature. The following screen shows the Mobility tab for User 3042.
The Mobility Features and Mobile Twinning boxes are checked. The Twinned Mobile
Number field is configured with the number to dial to reach the twinned telephone, in this case
919191111234. Other options can be set according to customer requirements.

IP Offices User

& BoOTP (9)
4 Operator (3)
ODENOFOES30F
i System (1)
1 Line (3

< Control Linik {4)
Ay Extension (35)
& User (a3
2§ HuntGroup (1)
P Short Code (62)
B service (0)
al RAS (1)
@ Incoming Call Route (2)
g wanPort ()
o Directory ()
£ Time Profile (0)
(& Firewall Profile (1)
A 1P Route (4)
@ Account Code (0)
W License (74)
W Tunnel (0)
3 User Rights (8)
¥ RS (1)
" RAS Lacation Request (0)
fx £911 System (1)

Mame
Ext3040 H323
" Ext3041 H323
Ext3042 H323
Ext3043 Digital
Ext3044 Digital
" Ext3047 SIP
y Ext3048 H323
Ext3049 Fax
j Ext3055 H323
Extn400z
Extn4003
Extn4004
Extn4005
Extn4006
Extn4007
Extn400g
Extnd4011
Extnd01z
Extn4013
Extn4014
Extn4015
Extn4016
Extnd4017
Extn4018
Extn4019
Extnd4020
Extn40z1
Extn402z
Extn4023
Extn4024
g hlolser
fmRemoteManager
§-sipaoso

Extension
3040
3041
3042
3043
3044
3047
3048
3043
3055

3050

[ tnternal Twinning

Twin Bridge Appearances

Twin Coverage Appearances

Twin Line Appearances
Mohility Features

Mohbile Twinning
Twinned Mobile Number

e e )
Twinning Time Prafile <Nane=
Mobile Dial Delay (secs) 4

Mabile Answer Guard {secsy |0 3

] Hunt group calls eligible For mabile bwinning
[] Forwarded calls ligible For mobils twinning
] Twin when Logged Out

[ one-x Mohile Clisnt

Mohile Call Contral

[ Mobile Callback

Ext3042 H323: 3042*

cf - X[« l<]>

ShortCodes | Source Numbers | Telephony | Forwarding | Dial In | Yoice Recording || Button Programming | Menu Programming | Mobiity | hane Manage ¢ *
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To program a key on the telephone to turn Mobile Twinning on or off, select the Button
Programming tab on the user, then select the button to program to turn Mobile Twinning on and
off, click on Edit = Emulation = Twinning. In the sample below, button 4 was programmed
to turn Mobile Twinning on and off on user 3042.

IP Offices User E

R BOOTP (%)
i Operatar (3)
=%y ODEDO7OG530F
2y System (1)
A7 Line (3)
< Control Unit [4)
A Extension (35)
§ User(a3)
3§ HuntGroup (1)
8¢ shart Code (62)
B service (0)
ol RAS (1)
@ Incoming Call Route (2)
) wanPort (0)
s Directory (0}
£7 Time Profile (0)
@ Frewal Profile (1)
BB IF Route (4)
m Account Cods (D)
., License (74)
W& Tunnel {0}
5 User Rights (5)
¥ ARS (1)
" RAS Location Request (0)
fx E311 System (1)

MName

Ext3040 H323
j Ext3041 H323
Ext3042 H323
Exk3043 Digital
Ext3044 Digital
jrr Exb3047 SIP
jr Exb3048 H3Z3
Exk3049 Fax
jrExb3055 H323
Extnd00z
Extnd003
Extn4004
Extnd00S
Extn4006
Extnd007
Extnd003
Extnd401l
Extnd0iz
Extn4013
Extnd0i4
Extndnis
Extnd016
Extnd0i?
Extnd01d
Extnd4019
Extndnzo
Extnd0z1
Extndnzz
Extnd023
Extndnz4

g MoLiser
iRemoteManager

&-sipanso

Ext3042 H323: 3042

Extension
3040
3041 Button ... | Label Action Action Data
304z 1 Appearance a=
3043 2 Appearance b=
3044 3 Appearance =
3047 4 Twinning
3048 5 Bridged Appearance Ext3040 H323;1
3048 6
3055 7
4002 3
4003 a
4004 10
4005 11
4006 12
4007 13
4008 14
4011 15
4012 16
4013 17
4014 18
4015 19
4016 20
4017 21
4018 55
4013 23
4020 24
4021 25
anzz 26
4023 57
4024 Edit Button

Button Mo, 4
5050 Label

Action Twinning

Action Data

ShartCades || Source Mumbers | Telephony | Forwarding | Disl In | oice Recording | Button Programming | Menu Programming | Mobilty | Phone Manage ¢ *

g - X v <]

] Remave
Edit. ..
Capy

Paste

Display all buttans

i
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5.9. Incoming Call Route

An incoming call route maps inbound DID numbers on a specific line to internal extensions, hunt
groups, short codes, etc, within the IP Office system. Incoming call routes should be defined for
each DID number assigned by the service provider.

In a scenario similar to the one used for the compliance test, only one incoming route is needed,
which allows any incoming number arriving on the SIP trunk to reach any predefined extension
in IP Office. The routing decision for the call is based on the parameters previously configured
for Call Routing Method and SIP URI (Section 5.6) and the users SIP Name and Contact,
already populated with the assigned TSTT DID numbers (Section 5.8)

From the left Navigation Pane, right-click on Incoming Call Route and select New.

On the Details Pane, under the Standard tab, set the parameters as show bellow:
e Set Bearer Capacity to Any Voice.
e Set the Line Group Id to the incoming line group of the SIP line defined in Section 5.6.
e Default values may be used for all other parameters.

IP Offices Incoming Call Route B 17 kB X<

K goote (s Line Group ID | Incoming Number | Destt || srandard | yoice Recording | Destinations
e Operator (3) @0 Diallry
=% D0EQDTOES30F el? .
3 System (1) Bearer Capability Any Waice ~
7 Line (3)
< Control Unit {4) Lhecon D
Ay Extension (35)
§ User(3m
2§ HuntGroup (1) Incaming Sub Address
#3¢ Short Code (62)
@ Service (0) Incoming CLI
A RAS (1)
@ Incoming Call Route {2)
2 WanPart (0) Priority 1-Low v
@ Directory {0)
£ Time Profile (0) Tag
@) Firewall Profile (1)
[P Route (4)
B Account Code (0)
W License (74)
& Tunnel (0)
§q User Rights (&)
& ARS (1)
# RAS Location Request (0)
fiu 911 System (1)

17 v

Incoming Mumber

Locale v

Hald Music Source System Source he

¢ Under the Destinations tab, enter “.” for the Default Value. This setting will allow the
call to be routed to any destination with a value on its SIP Name field, entered on the
SIP tab of that User, which matches the number present on the user part of the incoming
Request URL
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IP Offices Incoming Call Route

& BoOTR =) Line Group ID' | Incoming Number | Destj

47 Opetrator (3) o Dialtry |1 = = =
0E0070E530F 17 ; | TimeProfile Destination Fallback Extension

17 e -8 X[« <|

Standard | Yoice Recording Destinations:

9 System (1) 4 Defaul Value ; ~ v
7 Line (3) |

< Control Unit f4)
Ay Extension (35)
§ User(33)
2§ HuntGroup (1)
8¢ shart Code (62)
B service (0)
ol RAS (1)
@ Incoming Call Route (2)
) wanPort (0)
s Directory (0}
£ Time Profile (0)
@ Firewall Prafile (1)
BB IF Route (4)
i Account Cods (D)
., License (74)
@& Tunnel {0}
£ user Rights ()

¥ ARS (1)
" RAS Location Request (0)
fix E311 System (1)
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5.10. Short Code

Define a short code to route outbound traffic to the SIP line. To create a short code, right-click
on Short Code in the Navigation Pane and select New. On the Short Code tab in the Details
Pane, configure the parameters as shown below.
¢ In the Code field, enter the dial string which will trigger this short code, followed by a
semi-colon. In this case, 8N;. This short code will be invoked when the user dials 8
followed by any number.
e Set Feature to Dial. This is the action that the short code will perform.
¢ Set Telephone Number to N”@192.168.139.155”. This field is used to construct the
Request URI and To headers in the outgoing SIP INVITE message. The value N
represents the number dialed by the user. The IP address 192.168.139.155 represents the
IP address of the TSTT SIP proxy.
¢ Set the Line Group Id to the outgoing line group number defined on the SIP URI tab on
the SIP Line in Section 5.6.3. This short code will use this line group when placing
outbound calls.

e Default values may be used for all other parameters.

 rome | st | CEEIEIRITIE
R BOOTR (3) Code Telephonie bumber | | ([ shart code
{7 Operatar (3) 30 '
3 DDEOOTOES30F %31 ! Code an;
2y System (1) WEIE N
£ Line (3) P Feature | Dial v
< Control Unit (43 ;3N N | Telephone Number  |N"@192,168,139,155"
A Extension (35) [T |
5‘ ﬂsel;éﬁ) " o ] Line Group 1D 17 v
LoD BT N ! .
92 hort Coc (52} e ] Locale United States (US English) v
@ service (1) Pty 1 | Force Account Code  []
ol RAS (1)
@ Incoming Call Route (2) W40 1 |
) wanPort (0) Ll 1 !
s Directory (0) i !
£ Time: Prafile (1) etz 2 |
@ Firewall Profile (1) 4 z |
Bl T Route (4) L .
m Account Cods (D) L LS
., License (74) g7
& Tunnel (D) [ PO
5 User Rights (5) o !
¥ ARS (1) [ EE] |
# RAS Location Request (0) [ |
fx E311 System (1) e |
S N '
PRASTHE T |
BRETONE N |
PRATINE T |
BXFGO00*  MATNTENANCE" |
Wt w1t |
Wkozn; 2 |
Ix*99 31 |
PRADISN [OIS1/ERR - "N |
@X*SDN “[OM51/ERR -"N |
|- L] " [0IL5LJERR - "N |
oo oN'g |
on; M@ |
oz ' |
e N'@ |
LU i I
< 5 s [e]4 I [ Cancel ] [ Help
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5.11. Automatic Route Selection

Optionally, Automatic Route Selection (ARS) can be used rather than the simple short code
approach described above. With ARS, secondary dial tone can be provided after the access code.
Other features like time-based routing criteria and alternate routing can be specified so that a call
can re-route automatically if the primary route or outgoing line group is not available. ARS also
facilitates a more granular treatment for different types of calls, and permits a more specific
matching of the telephone number dialed following the access code. While detailed coverage of
ARS is beyond the scope of these Application Notes, and alternate routing was not used in the
reference configuration, this section includes some basic screen illustrations of the ARS settings
used during the compliance test.

To create a short code to be used for ARS, right-click on Short Code in the Navigation Pane and
select New. The screen below shows the short code 9N created. Note that the semi-colon is not
used here. In this case, when the Avaya IP Office user dials 9 plus any number N, instead of
being directed to a specific Line Group ID, the call is directed to Line Group 50: Main, which
is configurable via ARS.

IP Offices Short Code e-E X | e < |
R B0OTP () Corle Telephone Mumber | [ Mohort cods
¢« Operator {3) B30 '
=% DOEDO7O6530F BR+31 ' Code el
29 System (1 3z
= s Beeszie = 3
i BREIFNE N
= Control Unit (4) X34 N 1 Telephone Number M
?Emrgg; &= it ! Line Group ID 50: 1
ser i3 | ine Group : Main v
5% HuntGroup (1) P -
8 Short Code (62) el | Lacale United States (U5 English) v
B Service (0) o 1 | Force Account Code  []
L RAS (1)
P Incoming Call Route (2) 940 L |
¥ wanPort (0) ! 1 !
s Directory (0) a2 2 !
7 Time Profil {0} Pxra3 H [
@ Firewall Profile (1) BXHaq 2 I
Ell 17 Route (4) BRH4SHE N
@ Account Code (0) Bn+a
W License (74) 47
% Tunnel () X4
£ User Rights (8) Bx+ag {
¢ ARS(1) o |
@ RAS Location Request (0 || gy |
fx E9LL System (1) o ]
BRESTE N '
BRESTE N |
PRAFONE N |
BRETLNE N |
BXFI000%  "MAINTERANCE" 1
| R T IR |
LT TR T |
L act] 31 !
PHDSSN "[OISIERE - "N |
BN*SDN [OISERR - "N |
Bx+skn “[001S1/ERR - "N 1
ko e |
oin; W@ "
Bz ZN'E 1
ot '@ |
axan N I
v
< :
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The following screen shows the example ARS configuration for the route Main. Note the
sequence of Xs used in the Code column of the entries to specify the exact number of digits to be
expected, following the access code and the first digit on the string. This type of setting results in
a much quicker response in the delivery of the call by the IP Office. The example below shows
that for local calls, the user dialed 9, then 10 digit numbers starting with an 8. For calls to other
area codes in the North American Numbering Plan, the user dialed 9, followed by 11 digits,
starting with a 1.

IP Offices ARS B Main gh-EIx] ]|
R BoOTP (%) Mame  Time Profile RS
{# Operator (3) ¥ Main
2 % DOEONFOASA0F ARS Route Id ] Secondary Dial tone
i System (1)
9 Line (3 Raute Name SystemTone b
< Control Linik (4)
<y Extension (35) Dial Delay Time System Default (3) 5 Check User Call Barring
& User (a3
2§ HuntGroup (1)
B Short Code (62) In Service Out of Service Route <Mone> ~
B Service (0)
ol RAS (1) 1
@ Incoming Call Route (2)
g wanPort () Timne Prafile e} Out of Hours Route <Manes L3
o Directory ()
£33 Time Profile (0) 1
@ Firewall Profile (1)
R F Route (4] Code Telephone Number Feature Line Group ID
B Account Code (0) 11 911 Dial Emergency a
S License (74) 911 a1l Dial Emergency 0
% Tunnel (0) DRKRREERREREN o Dial 17
5 User Rights (8) BRI G Dial 17
¥ ARS (1) BRAZUKHRAR an Dial 17
o RAS Location Request (0) R i Dial 17
fi= E911 System (1)
ey filtEtNIakE ROUEE <Mone > ~
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5.12. Privacy/Anonymous Calls

For outbound calls with privacy (anonymous) enabled, Avaya IP Office will replace the calling
party number in the From and Contact headers of the SIP INVITE message with “restricted” and
“anonymous” respectively. Avaya IP Office can be configured to use the P-Preferred-Identity
(PPI) or P-Asserted-Identity (PAI) header to pass the actual calling party information for
authentication and billing. By default, Avaya IP Office will use PPI for privacy. For the
compliance test, PAI was used for the purposes of privacy.

To configure Avaya IP Office to use PAI for privacy calls, navigate to User = NoUser in the
Navigation Pane. Select the Source Numbers tab in the Details Pane. Click the Add button.

IP Offices User 7 e -8 X |<]>
N, Ext
& BOOTP (3) Sl Ak User | voicemail | DMD | ShortCodes | Source Mumbers | Telephary | Forwarding | Dial In | Yoice Recording | Button Programming | Menu Programmi € *
i Operatar (3) Ext3040H323 3040
= %3 ODEDOTOGS30F Ext3041 H3ZZ 3041 Source Number
7 System (1) Ext304zH3z3 3042
7 Line (3) Exk3043 Digital 3043 D
< Control Urit (4) Ext3044 Digial 3044 =
A Extension (35) e Ext3047 SIP 3047 Edit...
5‘. ﬂsertéﬁ) i [rEXB04E HIZE 3048
untGroup
Ext3040Fax 3048
8¢ shart Code (62)
|~Ext3055H3Z3 3055
Service (0
% RAS(I)( : Extnd002 4002
@ Incoming Call Route (2) T e
Extnd004 4004
) wanPort (0)
a8 Directory (0) Extnd00S 4005
£ Time Profile {0) ExEred0e Gl
@ Frewal Profile (1) Extrd007 4007
Bl F Route (4) Extnd008 4008
m Account Cods (D) Extnd01l 4011
S License (74) Extnd01z 4012
W& Tunnel (0} Extn4013 4013
i3 User Rights (8] Extrd014 4014
¥ ARS (1) Extnd015 4015
« RAS Location Request (0} Exkrdll6 016
fx E911 System (1) Extrd01? 4017
Extrd018 4018
Extnd01s 4019
Extnd020 4020
Extnd021 4021
Extnd0zz 4022
Extnd023 4023
Extrd0zd 4024
ghloiser
iRemoteManager
&-sipanso 3050

At the bottom of the Details Pane, the Source Number field will appear. Enter
SIP_USE_PAI_FOR_PRIVACY. Click OK.

Mews Source Mumber

Source Mumber SIP_LISE_PAI_FOR_PRIVACY

The SIP_USE_PAI_FOR_PRIVACY parameter will appear in the list of Source Numbers as
shown below.
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IP Offices User ﬁ NoUser: * ek -M X[ l<]>
N, Extensi
& BooTe (%) S B User | voicemail | DMD | ShortCodes | Source Mumbers | Telephany | Forwarding | Dial In | Yoice Recording | Button Programming | Menu Programmil € *
o Cperatar (3) Ext3040H3ZE 3040 -
=% DOEQD7OES30F - Ext3041 H3Z3 3041 Source Number
7 System (1) Ext3042HIZ3 3042
T4 Line (3) Exk3043 Digital 3043 SIP_USE_PAI_FOR._PRIVACY Remove
S Control Unit (4) Ext3044 Digital 3044 .
Ay Extension (35) b Ex3047 SIP 3047 Edit...
Eﬂ ﬂse’téﬁ) s [ Exta048 HIZZ 3048
untGroup
Ext3043Fax 3048
short Code (52
g S;;[g'z; &2 [ Ext3055 H323 3055
Extnd002 4002
RAS (1)
% Incoming Call Route (2) Extndnas 4003
Extrd004 4004
) wanPort (0)
% Directory (0) Extnd00S 4005
£ Time: Profile () Extnd006 4006
@ Frewal Profile (1) Extrd0? 4007
Bl P Route (4) Extnd008 4008
i Account Cods (D) Extnd01l 4011
S License (74) Extnd01z 4012
& Tunnel (0} Extnan13 4013
£ user Rights () Extn401l4 4014
¥ AR5 (1) Extnd015 4015
" RAS Location Request (0} Exkrdll6 016
fx E911 System (1) Extr01? 4017
Extrd018 4018
Extnd01s 4019
Extnd020 4020
Extnd021 4021
Extnd0z2 4022
Extnd023 4023
Extnd0zd 4024
ghioUser
WpgRemoteManager
&-sipanso 3050

5.13. Save Configuration

When desired, send the configuration changes made in Avaya IP Office Manager to the Avaya IP
Office server in order for the changes to take effect.

Navigate to File>Save Configuration in the menu bar at the top left of the screen to save the
configuration performed in the preceding sections.

Once the configuration is validated, a screen similar to the following will appear, with either the
Merge or the Immediate radio button chosen based on the nature of the configuration changes
made since the last save. Note that clicking OK may cause a service disruption due to system
reboot. Click OK if desired.

I A=)

IP DfFice Settings
O0EODFOES30F

Configur ation Reboot Mode
O Merge

(%) Immediate

() when Free

) Timed

Reboot Time

all Barring

[ l

[ =4 ” Cancel ][ Help ]
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6. Telecommunications Services of Trinidad and Tobago SIP
Trunking Configuration

TSTT is responsible for the configuration of the SIP Trunk Service. The customer will need to
provide the IP address used to reach the Avaya IP Office at the enterprise. TSTT will provide the
customer the necessary information to configure the Avaya IP Office SIP trunk connection,
including:

e [P address of the TSTT SIP Proxy server.

e Supported codecs and order of preference.

¢ DID numbers.

e All IP addresses and port numbers used for signaling or media that will need access to the

enterprise network through any security devices.

7. Verification Steps

The following steps may be used to verify the configuration:
e Use the Avaya IP Office System Status application to verify the state of the SIP
connection. Launch the application from Start > Programs - IP Office > System
Status on the PC where Avaya IP Office Manager was installed (not shown). Log in
using the appropriate credentials and select the SIP line of interest from the left pane. On
the Status tab in the right pane, verify that the Current State is Idle for each channel
(assuming there are no active calls).

IP Office System Status

ogOff  Exit  About

Alarms

Status | Utiization Summary

SIP Trunk Summary

Peer Domain Mame: Estt.co.tt

Resolved Address: 192.168.139.155

Line Mumber: 17

Murber of Administered Channels: 10

Murmber of Channels in Use: 1]

Administered Compression: G711 My, G729 A

Silence Suppression: Off

SIP Trunk Channel Licenses: Unlimited . -
SIP Trunk Channel Licenses in Use: a

SIP Device Feat 3

or  Other Party on Call

Idle 00:04:10
Idle: 00:04: 10

Idle 00:04:10
Idle 00:04:10
00:04:10

Idle: 00:04:10
Idle 00:04:10
Idle 00:04: 10
Idle: 00:04: 10
00:04:10

oo~ o o] s wfm]e
a
2

5
o
Ey
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e Select the Alarms tab and verify that no alarms are active on the SIP line.

AVAyA IP Office System Status

5 Alarms for Line: 17 SIP tstt.cott
Configuration (0) Alarms
& Service (1)
H & Trunks (4) .
& Line: 1 (2) ast Date Of Erroy Error Description
& Line: 2 (2)
»
Link (0}
Call Quality of Servic

® Verify that a phone connected to Avaya IP Office can successfully place a call to the
PSTN with two-way audio.

e Verify that a phone connected to the PSTN can successfully place a call to an Avaya IP
Office phone with two-way audio.

e The Avaya IP Office Monitor application can also be used to monitor and troubleshoot
SIP signaling messaging between TSTT and IP Office. Launch the application from Start
->Programs > IP Office > Monitor on the PC where Avaya IP Office Manager was
installed. The sample screen below shows part of the messages on an outbound call.

-1, Avaya IP Office RB.1 Syshlonitor - [STOPPED] Monitoring 172.16.5.60 (00E00706530F); Log Settings - C:\Documents and Settings\...\sysmonitorsettings.ini
=a ~gB %[ @ €=
520906ns SIi’ Tx: UDP .lS?.lBU:SUiSU £ .139.155: 50680
INVITE sip: 0788Atstr.co.tt SIF/2.0
Via: SIP/Z.0/UDP .157.190: 5060 rport;branch=z9hG4bKe80d9a681fde690b71e28aed253da3cE
From: "Ext3042 H323" <3ip: 3224@tstt. co. bt tag=6713hd725ba2320d
To: <sip: 0788ELsLt. co. L

Call-ID: agcc90flE0b36b3386c3304ecaallyns

CSeq: 1516841205 INVITE

Contact: "Ext3042 H323" <sip: Gzz4@ 157.190: 5060; transport=udp>
Max-Forwards: 70

Allow: INVITE, ACE, CANCEL, OPTIONS, BYE, REFER, NOTIFY, INF0, UPDATE
Content-Type: application/sdp

Supported: timer,l00rel

User-Agent: IF Office 8.1 (69)

P-dgzgerted-Identity: "Ext3042 H3Z3" <Lsip: 2240 L 157,100z 5060
Content-Length: 255

=0

o=Userd 1737825815 1871960305 IN IP4 .157.190
s=Seszion JDP

c=IN IFd .157.130

t=0 0

m=audio 43152 RTP/AVP O 18 101
asrtpmap:0 PCHU/3000

asrtpmap:l8 G729/8000

a=futp:ls anmexb=no

a=rtpmap: 101 telephone-svent/6000
asfutp:l0l 0-15

|~
|
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8. Conclusion

These Application Notes describe the procedures required to configure SIP trunk connectivity
between Avaya IP Office 8.1 and the Telecommunications Services of Trinidad and Tobago SIP
Trunk Service, as shown in Figure 1.

Interoperability testing was completed successfully with the observations/limitations noted in
Section 2.2.

9. Additional References

[1] IP Office 8.1, Installing IP500/IPS00 V2 Document Number 15-601042 - Issue 27n,
22 August 2013, https://downloads.avaya.com/css/P8/documents/100162521

[2] TP Office Manager R8.1 FP1, Document Number 15-601011 - Issue 29v 0, Friday,
August 30, 2013, https://downloads.avaya.com/css/P8/documents/100162522

[3] IP Office Release 8.1 Implementing Voicemail Pro, Document Number 15-601064 —
Issue 8b, Tuesday, December 11, 2012,
https://downloads.avaya.com/css/P8/documents/100163127

[4] IP Office 8.1 Using System Status, Document Number 15-601758 — Issue 07a, 24 May, 2013
https://downloads.avaya.com/css/P8/documents/100150298

[5] Avaya IP Office Knowledgebase, http://marketingtools.avaya.com/knowledgebase

Product documentation for Avaya products may be found at http://support.avaya.com.

Product documentation for the TSTT SIP Trunk Service is available from Telecommunications
Services of Trinidad and Tobago.
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Appendix: SIP Line Template

Avaya IP Office Release 8.1 supports a SIP Line Template (in xml format) that can be created
from an existing configuration and imported into a new installation to simplify configuration
procedures as well as to reduce potential configuration errors.

Not all of the configuration information is included in the SIP Line Template, therefore, it is
critical that the SIP Line configuration be verified/updated after a template has been imported,
and additional configuration be supplemented using Section 5.6 in these Application Notes as a
reference.

To create a SIP Line Template from the configuration described in these Application Notes,
configure the parameters as described below.

Use the Windows Registry Editor on the PC where Avaya IP Office Manager is installed to add a
new TemplateProvisioning registry entry. Select Start = Run. Enter regedit in the Open box.

Run @E|

- Type the name of a program, Folder, docurment, ar
= Internet resource, and Windows will open it Far you,

Open: v
[ O, l [ Cancel ] [ Browse, .
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On the Registry Editor, navigate to HKEY_CURRENT_USER - Software - Avaya
2>1P400. Right click on Manager and select New > DWORD Value.

Registry Editor

File Edit Wiew Favorites Help
= ) My Computer A | Hame Type Data ~
(0 HKEY_(LASSES_ROCT [R¥)navToOLBARR REG_DWORD 0x00000003 (3)
=0 HKEY_CLRRENT LISER [BEJNAVTOOLBARY  REG_DWORD 0%00000019 (25)
8 EEES:IZ”“ [®¥]nonThreadedTCP  REG_DWORD 0x00000000 {0)
(3 Contral Panel PasswordRequire... REG_DWORD Ox00000001 (1)
& Frwironment [®¥]promptvaidation  REG_DWORD 0x00000001 {1)
] Identities [R8]5CHBACKGROUN, ., REG_DWORD 0x00000001 (1)
(1 Keyboard Layaut SCNBACKGROUN..‘ REG_SZ
(2 Nebwork [R8]5cHDISCOVERY  REG_DWORD 0x00000000 (0)
(23 Printers SecureCommunic... REG_DWORD 000000001 {1}
{2 SessionInformation SecurityLeveI REG_DWORD 00000001 (1)
=11 Softwars g ServicesBasaHTT..‘ REG_DWORD 000000050 (50)
{21 Adobe ServicesBasePort REG_DWORD 0x0000c674 (S0804)
2 Alps SetR\ngDeIayPerAp REG_DWORD 000000000 {0}
=3 Avaya [R8]SHOWADMINTAS. .. REG_DWORD 0x00000001 (1)
(23 Avaya IP Softphone SHOWEerrPane REG_DWORD 000000000 {0}
(3 Avaya one-x Agent 28] SHowWInGroups REG_DWORD 0x00000000 {0
S || BESINI KA ey
o x|
g Fuaya one-K Communicator [R¥]SHOWNAYIGATL... REG_DWORD 0x00000001 (1)
oS | S e v
e %
g Efritv SHOWSHORTCU‘.. REG_DWIORD 0x00000001 (1)
(23 Integrator For Outlack SHOWSIMPLIFIE... REG_DW/ORD 0x00000001 {1)
=23 P40 SSLRemoteAccess REG_DWORD 000000000 (0}
ERE] 1noe [R¥]STARTINITIALDL.. REG_DWORD 0x00000001 {1)
[ ol Collapse I W TCPDisrvArvEnA.,. REG_DWORD 0x00000001 {13
(23 Red 4 Key REG_SZ 3
(1 Upgrad{  Find... String Yalue REG_DWORD 0x00000001 (1)
I v e a0 .
My Computer\HKEY_CURRENT LJSER  Fename

e " Multi-5tring Yalue
- xpo.r i Expandable String Value _
Permission

Right click the newly created entry and rename it to TemplateProvisioning. Double click the
entry and change the value under Value Data from “0” to “1”. Restart the PC.

Edit DWORD ¥alue

Y alue name:

| T emplatePravizianing |

Y alue data:; Baze
| | (%) Hexadecimal
() Decimal

[ Q. l [ Cancel
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To enable template support in the IP Office Manager, select File, then Preferences. On the
Visual Preferences tab, check the Enable Template Options box.

Hill’ Office Manager Preferences

| Preferences ” Diresckories " Driscowery | Wisual Preferences |Securit~;.f " '-.-'alidatiu:un|

Icon Size | Small A |

|:| Mulkiline Tabs
Enable Template Options

(i) | K, | | Cancel | | Help

To create a SIP Line Template from the configuration, on the left Navigation Pane, right click
the Sip Line (17), and select Generate SIP Trunk Template.

IP Offices

B SIP Line - Line 17 g -BIX[e]<]>

- & BOOTF (9) Line Number | Line Type Line 31| SIP Line | Transport|stP UR [volP | T35 Fax| stP Credentials|
~ g+ Operator (3) 1 PRI 24 (Universal) PRI
B ODEQDTOES30F {Universal) PRI Line Mumber 17 E
iy System (1) P
A7 Line (3) ] Hew » In Service
< Control Unit (4

& Extersion (3(5)) =] Generate SIP Trunk Template Use Tel URT ]
§ user(3m i Chrix Check 003
- HuntGroup (1) )
5 Short Code (62) 53 Copy Cr+C Call Rauting Method Request URI v
-l ?AS (1 s o 7 Delets e Farmarded and twinning calls
@ Incoming Call Route (2) Mame Priority System Defaul: v
2 wanPart (0) w7 validate
= Directory (0) > Caller ID from From headsr
£ Time Profile (0) : ! Send From In Clear O
@ Firewall Profis (1) Ren ficoiTenelateitbney) User-agent and Server l:l
IP Route (4) Export as Template (Binary) Headers
m Account Code (0) 4
W Licerse (74) Show In Groups

Tunnel (0! d :l"
W Tunpel () Customize Columns. ..
5 User Rights (&) — —
SE RS (1)
" RAS Location Request (0)
fiu 911 System (1) =

UPDATE Supparted | Allow v
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The trunk’s settings are displayed as configured in Section 5.6. Enter a descriptive name for the
template, adjust the settings if required, and then click on Export.

U3 SIP Trunk Template - (SIP Trunk - 17)

Please review and change the trunk settings if you want -

3IF Line | Transport | ValP | T38Fax || 5IP Credentials

Desciptive Name [TSTT IPO 8.1 |
ITSF Domain Name |tstt.co.tt |
Send Caller ID | Diversion Header |ﬂ|
Aizsociation Method | By Source IP address “ |
Inzorming Always
Outgoing Always
LPDATE Supported [l v

Lzer-dgent and Server Headers | |

Use Tel URI O

Check 005

Call Routing bethod |F|equest LRI w |
Originatar rurmber for | |
forwarded and twinning calls

Mame Priority | System Default v |
Caller 1D from From hizader

Send From In Clear O

[

Expart H Camcel ]

On the next screen, Template Type Selection, select the Country, enter the name for the
Service Provider, and click Generate Template.

"] Template Type Selection

Lozale IJnited States [US English)
CoLintry | Trimidad &nd Tobago L |
Cervice Provider | TSTT w |

[Generate Template][ Cancel ]

The following is the exported SIP Line Template file TT_TSTT_SIPTrunk.xml:

<?xml version="1.0" encoding="utf-8" ?>
<Template xmlns="urn:SIPTrunk-schema">
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<TemplateType>SIPTrunk</TemplateType>
<Version>20130913</Version>
<SystemlLocale>enu</SystemLocale>
<DescriptiveName>TSTT IPO 8.1</DescriptiveName>
<ITSPDomainName>tstt.co.tt</ITSPDomainName>
<SendCallerID>CallerIDDIV</SendCallerID>
<ReferSupport>false</ReferSupport>
<ReferSupportlncoming>1</ReferSupportIncoming>
<ReferSupportOutgoing>1</ReferSupportOutgoing>
<RegistrationRequired>false</RegistrationRequired >
<UseTelURI>false</UseTelURI>
<CheckOOS>true</CheckO0S>
<CallRoutingMethod>1</CallRoutingMethod>
<OriginatorNumber />
<AssociationMethod>SourceIP</AssociationMethod>
<LineNamePriority>SystemDefault</LineNamePriority >
<UpdateSupport>UpdateAllow</UpdateSupport>
<UserAgentServerHeader />
<CallerIDfromFromheader>true</CallerIDfromFromheader>
<PerformUserLevelPrivacy>false</PerformUserLevelPrivacy >
<ITSPProxy>192.168.139.155</ITSPProxy>
<LayerFourProtocol>SipUDP</LayerFourProtocol>
<SendPort>5060</SendPort>
<ListenPort>5060</ListenPort>
<DNSServerOne>0.0.0.0</DNSServerOne>
<DNSServerTwo>0.0.0.0</DNSServerTwo>
<CallsRouteViaRegistrar>true</CallsRouteViaRegistrar>
<SeparateRegistrar />

<CompressionMode>AUTOSELECT </CompressionMode>
<UseAdvVoiceCodecPrefs>true</UseAdvVoiceCodecPrefs>
<AdvCodecPref>G.711 ULAW 64K,G.729(a) 8K CS-ACELP</AdvCodecPref>
<CallInitiationTimeout>4</CalllnitiationTimeout>
<DTMFSupport>DTMF_SUPPORT_RFC2833</DTMFSupport>
<VoipSilenceSupression>false</VoipSilenceSupression>
<ReinviteSupported>true</ReinviteSupported>
<FaxTransportSupport>FOIP_NONE</FaxTransportSupport>
<UseOffererPrefferedCodec>false </UseOffererPrefferedCodec>
<CodecLockdown>false</CodecLockdown>
<Rel100Supported>true</Rel100Supported>
<T38FaxVersion>3</T38FaxVersion>
<Transport>UDPTL</Transport>
<LowSpeed>0</LowSpeed>

<HighSpeed>0</HighSpeed>
<TCFMethod>Trans_TCF</TCFMethod>
<MaxBitRate>FaxRate_14400</MaxBitRate>
<EflagStartTimer>2600</EflagStartTimer>
<EflagStopTimer>2300</EflagStopTimer>
<UseDefaultValues>true</UseDefaultValues>
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<ScanLineFixup>true</ScanLineFixup>
<TFOPEnhancement>true</TFOPEnhancement>
<DisableT30ECM>false</DisableT30ECM>
<DisableEflagsForFirstDIS>false</DisableEflagsForFirstDIS>
<DisableT30MRCompression>false</DisableT30MRCompression>
<NSFOverride>false</NSFOverride>

</Template>

To import the template into a new IP Office system, copy and paste the exported xml template
file into the Templates directory (C:\Program Files\Avaya\lP Office\Manager\Templates) on the
PC where IP Office Manager for the new system is running.

Next, import the template into the new IP Office system by creating a new SIP Line as shown in
the screenshot below. In the Navigation Pane on the left, right-click on Line then navigate to
New, New SIP Trunk From Template:

IP Offices SIP Line -Line 17
& BOOTP (%) Line Humber | Line Type Line 5\ (| S1P Line (transport||siP URI|volP | T35 Fax |SIF Credentials
% Operator (3) 1 PRI 24 {Universal) PRI
(= = DOEON7O6530F PRI 24 (Universal) PRI Line Mumber i =

w5y System (1) TP line
9 Line (3) 1 Mew » H323 Line

<+ Control Unit {4) : O
& Extension (35) ]| Generate SIP Trunk Template 1P DECT Line
§ User(33) g SIP Line

a cu Chrl+
3 HuntGroup (1) 4 5IP DECT Line
8% shart Code (62) 584 Copy Chrl+C Request URT v
@ Service (0) Mew SIP Trunk From Template s =
A RAS (1) ?: ‘ ol Tarwarded and twinning calls
Delete Chrl+Del
@ Inroming Call Route (2) Hame Priority System Default v
g warPort (0) W walidate
2w Directory (0) Caller 1D from From header
£ Time Profile (0) Send From In Clear O
@ Firewall Profile (1) Mevt From Templake (Binary) User-Agent and Server
@ 1P Route (4) Export as Template (Binary) Headers
m Account Code (0) v
W License (74) Show In Groups
@& Tunnel (0) = o hd
ustomize Columns...
3 User Rights (8)
S ARS (1)
' RAS Location Request (0)
fx ES11 System (1)
UPDATE Supported | Allow £

On the next screen, Template Type Selection, verify that the information in the Country and
Service Provider fields is correct. If more than one template is present, use the drop-down
menus to select the required template. Click Create new SIP Trunk to finish the process.

[ MES)

Locale
Covintry Trinidad And T obago w

Service Provider | TSTT w | ] Display &l

Create new SIP Trunk, ] [ Cancel ]
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